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COPYRIGHT
SOMA NETWORKS INC. ENDUSER PRODUCT LICENSE AGREEMENT

THE SOMAPORT™ SUBSCRIBER STATION AND PROVIDED SOFTWARE CONTAIN CERTAIN

COMPUTER PROGRAMS AND OTHER PROPRIETARY MATERIAL OF SOMA NETWORKS, INC. OR

LICENSED TO SOMA NETWORKS, INC., THE USE OF WHICH IS SUBJECT TO THIS AGREEMENT.

BY: (A) SIGNING AN AGREEMENT FOR SERVICE WITH YOUR SERVICE PROVIDER; (B) OPENING

THE SEALED ENVELOPE CONTAINING THE SOMAPORT; OR (C) USING THE SOMAPORT, YOU

ASSENT TO AND ACCEPT THIS ENDUSER PRODUCT LICENSE AGREEMENT. IF YOU DO NOT

AGREE WITH ALL THE TERMS OF THIS AGREEMENT YOU MUST RETURN THIS PRODUCT (WITH

THE ENVELOPE STILL SEALED), ALL MANUALS AND DOCUMENTATION, ANY SOFTWARE PACK-

AGES PROVIDED WITH THE SOMAPORT AND PROOF OF PAYMENT TO THE PLACE YOU

OBTAINED THEM FOR A FULL REFUND WITHIN THIRTY (30) DAYS OF FIRST ACQUIRING THE

SOMAPORT, OTHERWISE YOU ARE DEEMED TO HAVE ACCEPTED AND AGREED TO THESE

TERMS AND CONDITIONS. UNAUTHORIZED REPRODUCTION, DISTRIBUTION, DECOMPILATION

OR OTHER REVERSE ENGINEERING OF THIS PRODUCT INCLUDING ITS HARDWARE AND/OR

SOFTWARE, OR ANY PORTION OF IT, IS PROHIBITED AND MAY RESULT IN SEVERE CIVIL AND

CRIMINAL PENALTIES, AND WILL BE PROSECUTED TO THE MAXIMUM EXTENT POSSIBLE

UNDER THE LAW.

1. GRANT OF LICENSE: Subject to the terms of this Enduser Product License Agreement (the

"Agreement"), SOMA Networks, Inc. ("SOMA") grants you (the "Licensee") a non-sub-licensable,

non-exclusive right ("License") to use the Product. "Product" means, collectively, the Software and

the provided hardware, and specifically the SOMAport™ subscriber station and its accessories, if

any, together with documentation provided to you by SOMA or your service provider. "Software"

means, collectively, the version of the SOMA software program in object code format and all

updates to that program distributed to you by SOMA, directly or indirectly, by any means and

includes any firmware provided to you with the Product. You have no right, unless otherwise explic-

itly permitted, to receive any source code or design documentation relating to the Product. SOMA

retains ownership of all Software copies. The Software and this License is only provided to you to

be used in conjunction with the SOMAport provided to you by SOMA or your service provider when

you subscribed to services that utilize the SOMA wireless air interface technology and is not

licensed to you to be used for any other purpose.

2. RESTRICTIONS: Except as reasonably required to use the Product strictly in accordance with

the License and this Agreement, you may not copy any Software. Licensee shall not (and shall not

allow any third party to): (I) decompile, disassemble, or otherwise reverse engineer or attempt to

reconstruct or discover any source code or underlying ideas or algorithms or file formats or pro-

gramming or interoperability interfaces of the Product by any means whatsoever; (II) remove any

Product identification, copyright or other notices; (III) modify, incorporate into or with other software

or create a derivative work of any part of the Software or Product; or (IV) modify or otherwise alter

the operation of the Product. Various components, functions, routines and/or portions of the Prod-

uct may be protected by Intellectual Property Rights ("IPR") including, but not limited to, designs,

copyrights, trade secrets and one or more patents or pending patent applications. Licensee is

licensed under such IPR, if any, only to the extent that such a license is required by the licensee to

operate the Product in the manner intended by SOMA. No other rights are granted under such IPR
5



COPYRIGHT
and no right to repair or replace the Product is intended or provided and specifically, no right of

reconstruction, substitution or repair is provided.

3. TERMINATION: This License is effective until terminated. This License will terminate automatically

if you fail to cure any material breach, as determined at the sole discretion of SOMA, of this Agree-

ment within thirty (30) days after such breach first occurs (or immediately in the case of a breach of

§2). Upon termination, you shall immediately cease all use of the Product and return all of the Prod-

uct including Software, hardware, manuals, documentation of any kind accompanying Product to

the place where you first obtained such Product or such other location as may be designated from

time to time. Except for this License and except as otherwise expressly provided herein, the terms

of the Agreement shall survive termination.

4. WARRANTY DISCLAIMER: THE SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF

ANY KIND INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FIT-

NESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT. FURTHER, SOMA DOES NOT

WARRANT, GUARANTEE OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE

RESULTS OF THE USE, OF THE PRODUCT OR WRITTEN MATERIALS IN TERMS OF CORRECT-

NESS, ACCURACY, RELIABILITY, OR OTHERWISE. YOUR SERVICE PROVIDER MAY PROVIDE

FURTHER WARRANTY COVERAGE FOR YOU.

5. LIMITATION ON REMEDIES AND DAMAGES: SOMA SHALL NOT BE RESPONSIBLE OR LIABLE

UNDER ANY CIRCUMSTANCE WITH RESPECT TO ANY SUBJECT MATTER OF THIS ENDUSER

PRODUCT LICENSE AGREEMENT UNDER ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR

OTHER THEORY: (A) FOR LOSS OR INACCURACY OF RECORDS OR DATA OR (EXCEPT FOR

RETURN OF AMOUNTS PAID TO SOMA THEREFOR) COST OF PROCUREMENT OF SUBSTITUTE

GOODS, SERVICES OR TECHNOLOGY, (B) FOR ANY SPECIAL, INDIRECT, INCIDENTAL OR CON-

SEQUENTIAL DAMAGES INCLUDING, BUT NOT LIMITED TO, LOSS OF PROFITS, LOSS OF SAV-

INGS, (C) THIRD-PARTY CLAIMS AGAINST YOU FOR DAMAGES, OR (D) FOR ANY MATTER

BEYOND THE REASONABLE CONTROL OF SOMA EVEN IF SOMA AND / OR ITS SUPPLIERS IS/

ARE INFORMED OF THEIR RESPONSIBILITY. SOME JURISDICTIONS DO NOT ALLOW FOR THE

EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE

LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

6. UPDATES TO SOFTWARE and TRANSMISSION OF PERSONAL DATA: You consent to receive

and employ updates to Software, without requiring further notice to you, that may occur from time

to time, as may be necessary, as determined at the sole discretion of SOMA and/or your service

provider, for the use of Product by you and for the efficient utilization of services as may be pur-

chased or subscribed to by you from your service provider. You also agree to the application of the

terms of this Agreement to any and all such updates. You accept and acknowledge that Software

shall be able to transmit such data as is authorized by your service provider in order to allow for the

utilization of services subscribed or purchased by you in order to allow for the billing of such ser-

vices or as may be necessary by law.

7. MISCELLANEOUS: This Agreement and the License provided by this Agreement are not assign-

able or transferable by you without the prior written consent of SOMA. Any attempt by you to do so
6



COPYRIGHT
shall be void and void this License. Any notice, report, approval or consent required or permitted

hereunder shall be in writing. If any provision of this Agreement shall be adjudged by any court of

competent jurisdiction to be unenforceable or invalid, that provision shall be limited or eliminated to

the minimum extent necessary so this Agreement shall otherwise remain in full force and effect and

enforceable. This Agreement shall be construed pursuant to the laws of the United States of Amer-

ica and the State of California and without regard to conflicts of laws principles thereof. If success-

ful in any action to enforce this Agreement, SOMA shall be entitled to recover costs and expenses

including, without limitation, attorney's fees. The parties agree that a material breach of this Agree-

ment would cause irreparable injury to SOMA, or its suppliers, for which monetary damages would

be an adequate equitable relief and SOMA shall be entitled to any other remedies it may have avail-

able hereunder or at law. Both parties agree that this Agreement is the complete and exclusive

statement of mutual understanding of the parties and supersedes and cancels all previous written

and oral agreements and communications relating to the subject matter of this Agreement. BOTH

YOU AND SOMA AGREE AND ACKNOWLEDGE THAT SOMA RESERVES THE RIGHT TO AMEND

THE TERMS AND CONDITIONS OF THIS AGREEMENT WITHOUT FURTHER NOTICE TO YOU

OTHER THAN PROVIDING TO YOU THE AMENDED TERMS AND CONDITIONS OF THIS AGREE-

MENT. IF YOU DO NOT ACCEPT THE AMENDED TERMS AND CONDITIONS AS PROVIDED TO

YOU BY SOMA, THIS LICENSE SHALL TERMINATE IMMEDIATELY. ALL USE OF THE SOFTWARE

AND ANY SERVICES SUPPORTED BY THE PRODUCT AND SOFTWARE MAY CEASE OR BE

CAUSED TO BE CEASED WITHOUT ANY LIABILITY TO YOU BY SOMA AND YOU SHALL RETURN

ALL PRODUCT HARDWARE, MANUALS, DOCUMENTATION OF ANY KIND ACCOMPANYING

SOFTWARE TO THE PLACE WHERE YOU FIRST OBTAINED SUCH HARDWARE, MANUALS, DOC-

UMENTATION AND SOFTWARE
7



COPYRIGHT
8



PREFACE
Conventions

This section outlines the conventions used in this guide.

Measurement Conventions

Measurements in this guide are expressed according to the Systéme 
International d’Unites standards for metric units and abbreviation. 
Equivalent Imperial measurements (used in the United States) are 
provided in parentheses, except when Imperial is the international 
standard.

Bits and bytes are not abbreviated, though their prefixes are; for 
example, "kbits" for kilobits, "Gbytes" for gigabytes.

Trademark Identification

The SOMAport™ subscriber device, a trademark of SOMA Networks 
Inc., is referred to without notation in the rest of this document.
9
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Alerts Used in This Guide

WARNING: Where you see this symbol and the WARNING
heading, strictly follow the instructions to avoid personal
injury or damage to the product.

WARNING: Where you see this symbol and the WARNING
heading, strictly follow the instructions to avoid electric
shock.
10
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IMPORTANT SAFETY INSTRUCTIONS

For your safety and protection, read this entire guide before you 
attempt to install the SOMAport. In particular, read this safety section 
carefully. Keep this safety information where you can refer to it if 
necessary.

Installation

Read Instructions
Read and follow all of the safety and operating instructions before 
operating the SOMAport.

Retain Instructions
Retain the safety and operating instructions for future reference.

Follow Instructions
Follow all operating instructions.

Heed Warnings
Adhere to all warnings on the SOMAport and in the operating 
instructions.

Ventilation
Slots and openings in the SOMAport housing provide ventilation, 
ensure its reliable operation, and protect it from overheating. 
 

WARNING: One milliampere of current flowing through your
body can kill you. Voltage as low as 15 volts can kill under the
right conditions. Treat energized equipment with respect.
11
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Do not place the SOMAport in a closed-off location such as a 
bookcase or rack unless there is proper ventilation.

Setup Orientation
Keep the SOMAport in an upright, vertical position. Placing the 
SOMAport on its side or in other positions may interrupt its cooling 
and cause the unit to overheat.

Operating Environment
Avoid placing the SOMAport in an environment of high temperature 
and high humidity. In case of condensation found on the SOMAport, 
immediately unplug the power cord from the power outlet. 
Once the condensation disappears, re-insert the power plug into a 
power outlet. 

Power Sources
Use only the type of power source indicated on the label. If you are 
not sure of the type of power supplied to your home, consult your 
product dealer or local power company.

Power Supply Cord
The power supply cord is the disconnect device. Ensure that  the 
socket outlet is installed near the equipment and can be easily 
accessed.

Telephone Line Cord
To reduce the risk of fire, use only No. 26 AWG or larger telephone 
line cord.

WARNING: Do not block or cover these openings. The
openings prevent the SOMAport from overheating.

WARNING: The air from the top openings (holes) may be hot.
Do not touch the heated air as it may cause burning.
12
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Grounding or Polarization
The plug for the power cord on the SOMAport fits into the power 
outlet only one way. If you are unable to insert the plug fully into the 
outlet, contact your electrician to replace your outlet. To prevent 
electric shock, do not use this plug with an extension cord or outlet 
unless you can fully insert the blades without blade exposure. Do not 
defeat the safety purpose of this plug.

Power Cord Protection
Route power-supply cords so that they are not likely to be walked on 
or pinched by items placed upon or against them. Watch for wear in 
the cord at the plug and socket.

Accessories
To avoid personal injury or damage to the SOMAport, do not place it 
on an unstable cart, stand, tripod, bracket, or table.

Attachments
Do not use attachments with the SOMAport that have not been 
recommended in this guide as they may cause hazards.

Water and Moisture
Do not use the SOMAport near water or moisture.
13
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Maintenance and Servicing

Cleaning
Unplug the SOMAport from the wall outlet before cleaning. Use a dry 
cloth for cleaning. Do not use liquid or aerosol cleaners.

Servicing
Do not attempt to service the SOMAport yourself. Opening or 
removing covers may expose you to dangerous voltage or other 
hazards and may void the warranty. There are no user-serviceable 
parts inside. Refer all servicing to qualified service personnel.

Conditions Requiring Service
Unplug the SOMAport from the wall outlet and refer servicing to 
qualified service personnel under the following conditions:

The power supply or cord is damaged.

Liquid has been spilled on the SOMAport or it has been 
exposed to water.

An object has fallen into the SOMAport.

The SOMAport does not function normally even though you 
have adhered to the operating instructions and have made 
adjustments to only those controls covered by the operating 
instructions.

The SOMAport has been dropped and a change in 
performance has occurred.

The SOMAport exhibits a distinct change in performance.
14
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REGULATORY NOTICES

FCC Part 15 Notice (Applicable to Use Within the U.S.A)

This equipment complies with part 15 of the FCC Rules. Operation is 
subject to the following two conditions: (1) This device may not cause 
harmful interference, and (2) This device must accept any interference 
received, including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for 
a Class B digital device, pursuant to Part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no guarantee 
that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off and 
on, you can try to correct the interference by:

Relocating the SOMAport

Increasing the distance between the SOMAport and the  
device experiencing the interference

Connecting the equipment to an outlet on a circuit different 
from that to which the SOMAport is connected

ATTENTION: Changes or modifications not expressly approved
by SOMA Networks for compliance could void the user’s authority
to operate the equipment.
15
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FCC Radio-Frequency Exposure Notice

This equipment should be used in such a manner that the potential for 
human contact during normal operation is minimized. To avoid the 
possibility of exceeding the FCC radio frequency exposure limits, this 
equipment has to be installed and operated while maintaining a 
minimum body to antenna distance of 20 cm.

Industry Canada Notice (Applicable to Use Within Canada)

This equipment complies with the limits for a Class B digital device and 
conforms to Industry Canada standard ICES-003. 

Avis de Conformité à la Réglementation 
d’Industrie Canada

Cet appareil numérique de la classe B est conform à la norme 
ICES-003 du Canada.
16



PREFACE
Notice for European Community

Marking by the symbol 

The SOMAport complies with the R&TTE Directive 1999/5/EC. Such 
marking is indicative that this equipment meets or exceeds the 
following technical standards:

Radio

ETSI EN 301 753 - Fixed Radio Systems; Multipoint 
equipment and antennas; Generic harmonized standard 
for multipoint digital fixed radio systems and antennas 
covering the essential requirements under article 3.2 of 
the Directive 1999/5/EC

ETSI EN 301 489-1 - Electromagnetic compatibility and 
Radio spectrum Matters (ERM); ElectroMagnetic 
Compatibility (EMC) standard for radio equipment and 
services; Part 1: Common technical requirements 

ETSI EN 301 489-4 - Electromagnetic compatibility and 
Radio spectrum Matters (ERM); ElectroMagnetic 
Compatibility (EMC) standard for radio equipment and 
services; Part 4: Specific conditions for fixed radio links 
and ancillary equipment and services 

EMC

EN 300 386 - Electromagnetic compatibility and Radio 
spectrum Matters (ERM); Telecommunication network 
equipment; ElectroMagnetic Compatibility (EMC) 
requirements
17
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ETSI EN 55022:1998+A1:2000+A2:2003 (Class B) - 
Information technology equipment. Radio disturbance 
characteristics. Limits and methods of measurement

Safety

ETSI EN 60950-1:2001 - Information technology 
equipment-Safety-Part1: General requirements

WEEE (Directive 2002/96/EC) Compliance

Your product is designed and manufactured with high quality materials 
and components which can be recycled and reused.

This symbol means that electrical and electronic equipment, at their 
end-of-life, should be disposed of separately from your household 
waste. Please dispose of this equipment at your local community waste 
collection/recycling centre. In the European Union there are separate 
collection systems for used electrical and electronic products.

Please help us to conserve the environment we live in! 
18
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EU Declaration of Conformity

Safety Compliance Notice

This equipment has been tested and certified according to the 
following safety standards:

MET (Complies with UL 60950-1, CSA C22.2 No. 60950-1)

IEC 60950-1

EN 60950-1

DECLARATION OF CONFORMITY

SOMA Networks, Inc.,
185 Berry Street, Suite 4600

San Francisco, CA 94107 U.S.A.
(415) 882-6500

declares, that the product SOMAport complies with 
the requirements of the R&TTE Directive 1999/5/EC 

and carries the CE marking accordingly. 
19
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INTRODUCTION
This chapter provides an introduction to the SOMAport subscriber terminal. 
Please read this chapter to familiarize yourself with the features and operation of 
the device.

Contents

Overview .............................................................................................  22

The Front Panel ...................................................................................  23

The Back Panel ...................................................................................  25

The Internal Antenna ...........................................................................  27
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INTRODUCTION
OVERVIEW

The SOMAport™ subscriber terminal provides high-speed Internet 
access and telephone service. The SOMAport works like a cell phone, 
in that it communicates with your service provider’s network over the 
air and does not require a special wire connection.

Installation is easy. You simply plug-in the SOMAport and connect it to 
your computer using the provided Ethernet or USB (optional) cable. 
The SOMAport will automatically connect to your service provider and 
you can setup your account using a Web browser.

If you are using your SOMAport to provide telephone service, you can 
connect ordinary telephones to it.

Internet Access

The SOMAport provides a high-speed, "always on" Internet 
connection, which means you can be connected to the Internet and still 
use your telephone. The SOMAport is designed to be left on – you do 
not need to turn it off when not in use.

Telephone Service

The telephone service provided by the SOMAport is independent and 
separate from your phone service. Wireless services may differ from 
your traditional wired services. Consult your wireless service provider 
for details.
22



INTRODUCTION
THE FRONT PANEL

There are two lights on the front panel that indicate the state of the 
SOMAport: status and network.

NOTE: DO NOT unplug the SOMAport when the status light is flashing 
amber. The status light flashes amber during sensitive firmware upgrades 
only. Disconnecting or powering off the SOMAport during a firmware 
upgrade may damage the unit and render it nonfunctional.
23



INTRODUCTION
Status Light
The status light indicates whether or not the SOMAport is powered on 
and operating normally.

Network Light
The network light indicates if the SOMAport has located a base station.

State Description

Off The SOMAport is not receiving power.

Amber The SOMAport is booting and running its internal diagnostics.

Flashing Amber The SOMAport is upgrading its firmware. DO NOT unplug the 
SOMAport when this light is flashing. Disconnecting or 
powering off the SOMAport during a firmware upgrade may 
damage the unit and render it nonfunctional.

Green The SOMAport is powered and operating normally.

Red An error occurred. The SOMAport is not currently functional.
See page 54 “There is a fault condition” in the section of 
“Troubleshooting”.

Status Description

Off The SOMAport is not receiving power.

Amber The SOMAport is attempting to locate a base station.

Flashing Amber The SOMAport cannot locate a base station.

Flashing Green The SOMAport has located a base station and is attempting 
to establish a connection.

Green The SOMAport has located a base station and has 
established a connection.

Red An error occurred. The SOMAport is not currently functional.
See page 54 “There is a fault condition” in the section of 
“Troubleshooting”.
24
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THE BACK PANEL

The jacks and ports for connecting other devices to the SOMAport are 
on the back panel, as shown below:
25
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Part Description

Ethernet port Use this port with the supplied Ethernet 
cable to connect the SOMAport to a 
computer or hub.

USB port
(optional)

Use this port with the USB cable to 
connect the SOMAport to a computer. 
This type of connection is intended for 
use with computers that do not have an 
Ethernet port.

Telephone jacks Use these jacks to connect telephones 
to the SOMAport. The SOMAport can 
provide up to two independent telephone 
lines, depending on your service 
provider.

Power jack Use this jack to connect the power 
supply.

WARNING: To reduce the risk of fire, use only No. 26 AWG
or larger telephone line cord to connect to the telephone
jacks on the SOMAport.
26



INTRODUCTION
THE INTERNAL ANTENNA

The SOMAport communicates with a cellular tower operated by your 
wireless service provider. The SOMAport contains an antenna that 
automatically steers itself toward the best signal when you plug in the 
SOMAport. It also periodically checks to see if the current antenna 
direction is optimal and adjusts automatically if required. So, if you 
move the SOMAport without unplugging it, and the antenna direction is 
no longer optional, the SOMAport automatically steers the antenna to 
improve performance.

WARNING: While this device is in operation, a separation
distance of at least 20 centimeters (8 inches) must be
maintained between the radiating antenna and any person
exposed to the transmitter in order to meet the FCC RF
exposure guidelines. No change to the antenna or device is
permitted. Doing so may result in the installed system
exceeding RF exposure requirements. This device must not
be co-located or operating in conjunction with any other
antenna or radio transmitter. Installers and end users must
follow the installation instructions provided in this guide.
27
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INSTALLING THE SOMAPORT
This chapter describes how to install the SOMAport and activate service. 
After following the procedures described in this chapter, your SOMAport should 
be fully functional.

Contents

Unpacking the SOMAport ..................................................................... 30

Choosing the Best Location .................................................................. 31

Connecting the Power Supply and Powering on the SOMAport ..........  32

Connecting a Computer via Ethernet ...................................................  34

Connecting a Computer via USB (Optional) .........................................  35

Connecting Telephones to SOMAport .................................................  37

Activating Service ................................................................................  42
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INSTALLING THE SOMAPORT
UNPACKING THE SOMAPORT

Unpack the SOMAport and make sure you have all the pieces shown 
below. Find the SOMAport serial number on the bottom of the unit and 
write it down. You may need this number if you call for technical 
support.

SOMAport Serial Number:

 ___________________________________________

 

30



INSTALLING THE SOMAPORT
CHOOSE THE BEST LOCATION

Although the SOMAport’s internal antenna is self-steering, you can 
optimize signal reception by following these recommendations when 
choosing a location:

Allow at least 46 centimeters (18 inches) of space around the 
SOMAport.

If your home or office has multiple floors, place the SOMAport 
on one of the upper floors, if possible. Avoid putting it in the 
basement.

Place the SOMAport higher up in a room. For example, 
putting it on a desk or shelf will give you a stronger signal than 
if you place it on the floor.

Place the SOMAport near a window.

Avoid placing the SOMAport close to certain electronic 
devices, such as microwave ovens and computer monitors, 
as they can cause interference.
31



INSTALLING THE SOMAPORT
CONNECTING THE POWER SUPPLY AND 
POWERING ON THE SOMAPORT

The SOMAport does not have a power switch. You turn on the 
SOMAport by plugging it into a power outlet, and turn it off by 
unplugging it. When you plug in the SOMAport, it starts, connects to 
your service provider’s network, and establishes a connection.

To connect the power supply and power on the SOMAport

1 Insert the DC plug on the power supply cord into the power jack on the back of 
the SOMAPort.

WARNING: Use only the power supply and power cord that
come with the SOMAport. Using another power supply may
damage your equipment and poses the risk of shock or
electrocution.
32



INSTALLING THE SOMAPORT
2 Insert the socket end of the power cord into the power supply’s receptacle. 

3 Insert the plug end of the power cord into a three-prong grounded power outlet. 

There is no power button. The light on the power supply turns on when it is 
receiving power. 

4 The SOMAport takes up to five minutes to start, acquire a radio signal, and 
connect to the network. Wait for the network light on the front panel to turn green 
before you attempt to use the SOMAport.

NOTE: If you ever need to disconnect the SOMAport, unplug the power 
cord from the wall power outlet first and then unplug the connector from 
the back of the SOMAport.

WARNING: The power supply cord is the disconnect device.
Ensure that  the socket outlet is installed near the equipment
and can be easily accessed.
33



INSTALLING THE SOMAPORT
CONNECTING A COMPUTER VIA ETHERNET

If your computer has an Ethernet port, use the supplied Ethernet cable 
to connect your computer to the SOMAport.

NOTE: If your computer does not have an Ethernet port, you can use a 
USB cable, if supported by your SOMAport. Otherwise, you will need to 
purchase an Ethernet card or an Ethernet-to-USB adapter. Contact your 
service provider for information about supported hardware.

To connect a computer via Ethernet

1 Insert one end of the supplied Ethernet cable into the Ethernet port on the back of 
the SOMAport.

2 Insert the other end of the cable into the Ethernet port on your computer.
34



INSTALLING THE SOMAPORT
CONNECTING A COMPUTER VIA USB (OPTIONAL)

If your computer does not have an Ethernet port and it is running 
Windows 98SE, ME, 2000, or XP, you can use the supplied USB cable 
to connect your computer to the SOMAport.

NOTE: Ethernet is the preferred type of connection. The USB connection 
should only be used in computers that do not support Ethernet.

To connect a computer via USB 

1 Insert the SOMAport USB Drivers CD into the CD-ROM drive on the computer.

2 Plug the square connector on the USB cable into the USB port on the back of the 
SOMAport.

3 Plug the flat connector into the USB port on your computer.
35



INSTALLING THE SOMAPORT
A hardware wizard window opens.

You will see the following message at the beginning of the installation:

The software you are installing for this hardware:
SOMAport USB (SOMAport.SYS) has not passed Windows Logo 
testing to verify its compatibility with Windows.

Click Continue Anyway. The drivers have passed stringent 
internal testing by SOMA Networks, Inc.

4 Follow the on-screen instructions in the wizard, making sure you select the values 
indicated in the following table for your version of Windows.

5 Close the wizard windows and remove the CD from the drive. If prompted to do 
so, reboot your computer.

Version Selections

Windows 98 When prompted for the type of search, select Search 
for the best driver for your device.

When prompted for a location, select CD-ROM drive.

Insert the Windows 98 Second Edition CD if 
prompted.

Windows 2000 When prompted for the type of search, select Search 
for a suitable driver for your device.

When prompted for a location, select CD-ROM 
drives.

Windows ME When prompted for the type of search, select 
Specify a location.

When prompted for a location, select Removable 
Media.

Windows XP When prompted for the type of search, select Install 
the software automatically.
36



INSTALLING THE SOMAPORT
CONNECTING TELEPHONES TO SOMAPORT

In order to use a telephone with your SOMAport, you will need to 
subscribe to your service provider’s telephone service during service 
activation.

If telephone service is not available in your area or if you do not want to 
use telephones with your SOMAport, skip to "Activating Service" on 
page 42.

Telephone Jacks

There are two telephone jacks on the back of the SOMAport, 
one for line 1 (lower one) and the other for line 2 (upper one).

How you connect telephones to the SOMAport depends on three 
things:

The number of lines you subscribe to (one or two)

The number of telephones you connect to the SOMAport

The type of telephones you connect 
(one-line or two-line telephones)
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INSTALLING THE SOMAPORT
Lines Connecting One 
Telephone

Connecting Two Telephones

One Use the line 1 (lower one) jack. 
See "To connect a single 
telephone" on page 39.

Insert a duplex adapter into the line 1 
(lower one) jack and then connect 
both telephones to the adapter. See 
"To connect two telephones (when 
you have one line)” on page 41.

Two Use the line 1 (lower one) jack. 
See "To connect a single 
telephone" on page 39.

Connect telephones to both jacks. 
See "To connect two telephones 
(when you have two lines)" on page 
40.
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INSTALLING THE SOMAPORT
To connect a single telephone to the SOMAport

1 Insert the free end of the telephone cable into the line 1 (bottom) jack on the 
SOMAport.

NOTE: To connect a two-line telephone, you need to subscribe to two 
lines.
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INSTALLING THE SOMAPORT
To connect two telephones (when you have two lines)

1 Connect the cable of the telephone you want serviced by line 1 to the line 1 
(bottom) jack on the SOMAport.

2 Connect the cable of the telephone you want serviced by line 2 to line 2 (top) jack 
on the SOMAport.

NOTE: If you have a two-line telephone, connect it to the line 1 (bottom) 
jack.
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INSTALLING THE SOMAPORT
To connect two telephones (when you have one line)

1 Insert a dual-jack extension cord or adapter into the line 1 (bottom) jack of the 
SOMAport.

2 Insert the free end of one telephone cable into one of the jacks on the adapter.

3 Insert the free end of the second telephone cable into the other jack on the 
adapter.

To test your SOMAport telephone service

Pick up the receiver and listen for dial tone.

If you hear a standard dial tone, the SOMAport is connected to your service 

provider’s network. You may have to activate full service if your service provider has 
not done so already. See "Activating Service" on page 42.

If you hear a series of tones, the SOMAport is still starting. Hang up, and listen again 

in a few minutes.

If you hear silence, see "Finding Causes of Telephone Problems" on page 50.
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INSTALLING THE SOMAPORT
ACTIVATING SERVICE

After the SOMAport powers on, it will be in one of two service modes:

Restricted access: Your SOMAport remains in this mode 
until your account is activated by your service provider. You 
can use the SOMAport only to contact your service provider 
to activate full service, either by telephone or through the 
service provider’s Web site. You cannot receive telephone 
calls in this mode, although you can place a call to an 
emergency service (for example, 911 in North America).

Full-service access: You can browse any site on the 
Internet, receive telephone calls, and place calls to any 
telephone number.

To activate full service

1 Restart your computer while it is connected to the powered-on SOMAport.

2 Launch a Web browser.

3 Direct your browser to a known valid Internet address 
(such as www.google.com).

If the page opens, full service has already been activated and you can begin 

using your SOMAport for Internet service.

If you are redirected to your service provider’s Web page, complete the sign-

up procedure on the Web site to activate full service.

If you can not open any Web pages at all, see "Finding Causes of Computer 
Problems" on page 48.

NOTE: If you subscribe only to telephone service, activate full service by 
calling your service provider’s assistance center.
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CONNECTING MULTIPLE COMPUTERS
This chapter explains how to install the SOMAport as an Internet gateway for a 
local area network. Follow the procedures in this chapter if you want to connect 
multiple computers.

Contents

Overview .............................................................................................  44

Using an Ethernet Hub ........................................................................  45

Using an Internet Router ......................................................................  46
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CONNECTING MULTIPLE COMPUTERS
OVERVIEW

A hub, switch, or router is required in order to share the Internet 
connection with multiple computers. The SOMAport functions as a 
DHCP server (it automatically assigns IP addresses to devices attached 
to it) and will work with most consumer home network devices.

The connection procedure differs slightly depending on the type of your 
home network device.

When using a hub or switch, see "Using an Ethernet Hub" on page 45.

When using an Internet router see "Using an Internet Router" 
on page 46.
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CONNECTING MULTIPLE COMPUTERS
USING AN ETHERNET HUB

An Ethernet hub or switch (referred to generically in this section as a 
"hub") can be used to have multiple computers share an Internet 
connection from a single SOMAport.

NOTE: Each computer connected to the hub requires an IP address 
assigned to it by your service provider. Contact your service provider for 
information about provisioning an account that can use several IP 
addresses.

To use an Ethernet hub with the SOMAport

1 Choose a location and power on the SOMAport, as described in chapter 
"Connecting the Power Supply and Powering on the SOMAport” on page 32.

2 Wait for the SOMAport to find a base station.

3 Connect the SOMAport to the hub:

i Insert one end of a straight-through Ethernet cable into the Ethernet port on 
the back of the SOMAport.

ii Insert the other end of the cable into an uplink port (sometimes labeled as a 
WAN or Internet port) on the hub.

NOTE: If the hub does not have an uplink port, you may connect to the 
SOMAport using an Ethernet port (which may be labeled as a switched, 
LAN, or numbered port) on the hub. However, you must obtain and use a 
crossover Ethernet cable (not shipped with the SOMAport) to make this 
connection.

4 Power on the hub.

5 Connect each computer to an Ethernet port on the hub.

6 Reboot each computer.
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CONNECTING MULTIPLE COMPUTERS
USING AN INTERNET ROUTER

An Internet router, supporting either Ethernet or WiFi (802.11) 
connections, can be used to have multiple computers share an Internet 
connection from a single SOMAport.

To use an Internet router with the SOMAport

1 Choose a location and power on the SOMAport, as described in chapter 
"Connecting the Power Supply and Powering on the SOMAport” on page 32. 

2 Wait for the SOMAport to find a base station.

3 Power on the router.

4 If necessary, configure the router to use DHCP when obtaining an external IP 
address. See the documentation for your router for specific configuration 
Information.

5 Connect the SOMAport to the router:

i Insert one end of a straight-through Ethernet cable into the Ethernet port on 
the SOMAport.

ii Insert the other end of the cable into an uplink port (sometimes labeled as a 
WAN or Internet port) on the router.

6 Connect each computer to the Internet router. See the documentation for your 
router for information.
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TROUBLESHOOTING
This chapter describes the problems the SOMAport may exhibit, the possible 
causes of those problems, and the actions you should take to fix them.

Contents

Finding Causes of Computer Problems ...............................................  48

Finding Causes of Telephone Problems ...............................................  50

The Signal is Weak ..............................................................................  52

There is a Fault Condition ....................................................................  54

The SOMAport is Not Receiving Power ...............................................  55

There is a Problem with the Ethernet or USB Cabling ..........................  56

There is a Problem with the USB Port Settings ....................................  58

The Computer Uses an Old Dial-up Connections ................................  59

Internet Explorer LAN Settings are Incorrect ........................................  61

Ethernet Network Settings are Incorrect ..............................................  62

IP Address Needs to be Renewed .......................................................  72
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TROUBLESHOOTING
FINDING CAUSES OF COMPUTER PROBLEMS

Look up the problem you are experiencing and follow the suggested 
actions. If the recommended actions do not fix the problem, contact 
your service provider.

Problem Possible causes Action

You cannot 
connect to the 
Internet

Network settings for an 
Ethernet connection are 
incorrect.

See "Ethernet Network settings 
are Incorrect" on page 62.

Signal has been dropped. Unplug the SOMAport and plug 
it back in again.

The SOMAport is not 
receiving power.

See "The SOMAport is Not 
Receiving Power" on page 55.

The SOMAport experienced 
a fault condition during 
startup.

See "There is a Fault Condition" 
on page 54.

No connection between the 
computer and the 
SOMAport.

See "There is a Problem with 
the Ethernet Cabling" on page 
56.

You are using Internet 
Explorer and the LAN 
settings are not properly 
configured.

See "Internet Explorer LAN 
Settings are Incorrect" on page 
61.

Signal is weak. See "The Signal is Weak" on 
page 52
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TROUBLESHOOTING
It takes a long 
time to open a 
Web page

Internet congestion. Try again.

Signal is weak. See "The Signal is Weak" on 
page 52.

Cable connecting the 
computer to the SOMAport 
is damaged.

Replace the cable.

It takes a long 
time to open a 
Web page

Your Ethernet interface is in 
full-duplex mode. 
(This applies only if your 
SOMAport is directly 
connected to the Ethernet 
port on your computer, 
rather than through a hub.)

Use the appropriate system 
control to change the duplex 
setting of your Ethernet port to 
half-duplex. Refer to the 
documentation for your 
operating system.

Making a 
wireless 
Internet 
connection is 
prevented by 
old dial-up 
default

Computer is set up to 
connect to the Internet via 
dial-up by default.

See "The Computer Uses an 
Old Dial-UP Connection" on 
page 59.

You cannot 
send Email

SMTP server associated 
with your existing email 
account is not accessible.

Use a Web account, such as 
Yahoo, for sending and 
receiving messages.

Problem Possible causes Action
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TROUBLESHOOTING
FINDING CAUSES OF TELEPHONE PROBLEMS

Look up the problem you are experiencing and follow the suggested 
actions. If the recommended actions do not fix the problem, call your 
service provider.

Problem Possible causes Action

Irregular dial 
tone

If you hear a series of tones 
(not a regular dial tone) 
before you attempt a call, 
the SOMAport has not yet 
acquired a signal.

Wait a few minutes and try 
again.
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TROUBLESHOOTING
No dial tone If you hear a "fast busy" 
tone after you attempt to 
dial a number, you have not 
yet acquired a signal.

Activate full service as 
described in "Activating 
Service" on page 42.

If your telephone is 
connected to line 2 and you 
hear silence before dialing a 
call, you are in restricted 
mode.

Activate full service as 
described in "Activate Service" 
on page 42.

Cable connections are not 
secure.

Make sure the telephone cable 
is securely connected to the 
SOMAport and the telephone.

Telephone cable is inserted 
into the SOMAport’s  
Ethernet port

Make sure that the telephone is 
connected to a telephone jack.

Telephone is broken. Try a telephone that is known 
to work. If you were using a 
cordless telephone, try using a 
corded one.

SOMAport experienced a 
fault condition during 
startup.

See "There is a Fault Condition" 
on page 54.

SOMAport is not receiving 
power.

See "The SOMAport is not 
Receiving Power" on page 55.

No dial tone Signal is weak. See "The Signal is Weak" on 
page 52.

Voice quality is 
poor

Signal is weak. See "The Signal is Weak" on 
page 52.

Telephone is broken. Try a telephone that is known 
to work. If you were using a 
cordless telephone, try using a 
corded one.

Calls are 
dropped

Signal is weak. See "The Signal is Weak" on 
page 52.

Problem Possible causes Action
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TROUBLESHOOTING
THE SIGNAL IS WEAK

The signal to your SOMAport may be weak if you are having any of the 
following problems:

Telephone voice quality is poor or calls are dropped.

It takes a long time to open a Web page.

You cannot browse the Internet at all.

To improve reception quality

If you are experiencing an outgoing performance problem, try the following steps:

1 Make sure you have located the SOMAport according to the guidelines listed in 
“Choose the Best Location” on page 31.

2 See if a nearby appliance is disrupting the signal. Do the following for each 
appliance, testing one appliance at a time:

i Turn off the appliance.

ii While the appliance is off, check if the network performance improves.

If there is an improvement, reposition either the appliance or the 
SOMAport so that they are further apart.

If there is no improvement, turn the appliance back on and try another 

appliance.

3 If you cannot improve reception in the SOMAport’s current location, try moving it 
to another location that meets the guideline on page 31.
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TROUBLESHOOTING
Persistent Reception Difficulties

Reception can be temporarily affected by severe weather conditions 
such as heavy storms, ice, or strong winds. Problems may persist in 
the absence of these conditions if:

There are obstructions – tall buildings, trees, or mountains 
– between your SOMAport and the nearest 
communications tower.

Your SOMAport is located at the outer limit of the 
coverage area.

Contact your service provider if you experience persistent signal 
reception difficulties.
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TROUBLESHOOTING
THERE IS A FAULT CONDITION

This section describes how to restart the SOMAport. If the status light 
is red, the SOMAport has detected a fault. In this situation, restart the 
SOMAport. Also, if you cannot solve a problem with any of the 
procedures above, try restarting.

To restart SOMAport

1 Unplug the SOMAport from the wall power outlet and leave it off for at least 10 
seconds.

2 Plug the SOMAport back in.

Wait until the status light on the front panel is green, which indicates that the 

SOMAport is receiving a radio signal. 

If the problem is not solved, please call your service provider.
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TROUBLESHOOTING
THE SOMAPORT IS NOT RECEIVING POWER

If the light on the power supply and the status light on the SOMAport 
are off, the SOMAport is not receiving power. Try each of the actions in 
the following procedure until you locate the source of the problem.

To check the power

1 Make sure the power cord which connects the power supply to the wall outlet is 
securely connected to the power supply and the wall outlet.

2 Make sure the power cord which connects the power supply to the SOMAport is 
securely connected to the power jack on the back of the SOMAport.

3 Make sure the wall receptacle is working by plugging in an appliance which you 
know works.

4 Check the circuit breaker.

5 If you cannot find the source of the problem, call your service provider.
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TROUBLESHOOTING
THERE IS A PROBLEM WITH
THE ETHERNET OR USB CABLING

If there is a problem with the physical connection between the 
SOMAport and your computer or hub, you will not be able to browse 
the Internet.

Ethernet connection

There are two lights on the Ethernet port that indicate the status of the 
Ethernet connection: link (green), and data transmit (amber).

If the link light is off, the connection between the SOMAport and the 
Ethernet device is not working or does not exist.

The data transmit light flashes when data is being transmitted across 
the link. It is normal for this light to be off much of the time.

To check Ethernet cabling

1 Make sure the cable connectors are firmly inserted in the appropriate Ethernet 
ports on the SOMAport and computer or hub.

2 Make sure you are using the correct type of cable:

3 Make sure the length of the cable does not exceed 50 meters (167 feet).

4 If none of the previous steps solves the problem, replace the cable.

NOTE: You can replace the cable while the SOMAport is on.

Configuration Cable Type Provided

Ethernet port of a computer Straight-through Yes

Uplink port of a hub Straight-through Yes

Ethernet port of a hub Crossover No
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TROUBLESHOOTING
USB connection

There is no link light on the USB port. If you are using USB to connect 
your computer to the SOMAport and you suspect there is a problem 
with the physical connection, check the USB cabling.

To check USB cabling

1 Make sure the cable connectors are firmly inserted in the appropriate USB ports 
on the SOMAport and the computer or hub.

2 Make sure the length of the cable does not exceed 5 meters (15 feet). 

3 If you are using a USB extension cable, check to see if it is faulty by removing the 
USB extension and using a single USB cable between the SOMAport and the 
computer.

You may have to reposition the SOMAport to do this.

4 Replace the USB cable.

You can replace the cable while the SOMAport is on.
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TROUBLESHOOTING
THERE IS A PROBLEM WITH
THE USB PORT SETTINGS

If you are having problems getting the USB connection to work, ensure 
that your computer’s USB port is enabled and properly set up.

To check your PC’s USB port settings

1 Open the Control Panel:

In Windows 98 and 2000 and ME, choose Start → Settings 

→ Control Panel.

In Windows XP, choose Start → Control Panel.

2 Double-click the System icon.

3 Open the Device Manager:

In Windows 98 and ME, click the Device Manager tab.

In Windows 2000 or XP, click the Hardware tab and then click the Device 
Manager button.

4 Display devices by type:

In Windows 95 and 98 and ME, make sure the View devices by type radio 
button is enabled.

In Windows 2000 and XP, select View → Devices by type.

5 Click the plus (+) icon next the Universal Serial Bus controller option. If the 
following drives are listed, USB is enabled and you can use the USB port:

USB Host Controller

USB Root Hub

If these drives are not listed, there are two possible reasons:

You have a USB Host Controller installed in your PC, but the USB port is not 

enabled. See your computer’s documentation for instructions on how to run 
your computer’s BIOS Setup program to enable the USB port.

You do not have a valid USB Host Controller installed in your PC. You cannot 

use USB until you install a valid USB Host Controller.
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TROUBLESHOOTING
THE COMPUTER USES
AN OLD DIAL-UP CONNECTIONS

If you have switched from a dial-up Internet service when you 
subscribed to wireless SOMAport Internet service, you may still be 
prompted to connect to the Internet using the old dial-up connection. If 
this is the case, follow this procedure to ensure that your dial-up 
connection is not automatically activated whenever you attempt the 
Internet connection.

To disable the automatic dial-up connection in Windows

1 Open the Control Panel.

In Windows XP – Choose Start → Control Panel.

In all other versions of Windows – Choose Start → Settings 

→ Control Panel.

2 Double-click the Internet Options icon.

The Internet Properties window opens.

3 Click the Connections tab.

4 Enable the Never dial a connection checkbox. 

5 Click OK.

NOTE: If you are still unable to display a Web page, check your browser to 
make sure it is in online mode.

To disable the automatic dial-up connection in Mac OS 8 and 9

1 Click the Apple icon and choose Control Panels.

2 Click Remote Access.

3 Click Options.

4 Click the Protocol tab.
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TROUBLESHOOTING
5 Make sure the Connect automatically when starting TCP/IP applications 
box is disabled.

6 Click OK.

7 Choose File → Quit.

8 Click Save when prompted to save the current configuration.

To disable the automatic dial-up connection in Mac OS X

1 Click the Apple icon and choose System Preferences.

2 Click the Network icon.

3 Click Show.

4 Select Network Port Configurations from the pull-down list.

5 Disable the On checkbox for the dial-up modem.

6 Click Apply Now.
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TROUBLESHOOTING
INTERNET EXPLORER LAN SETTINGS
ARE INCORRECT

If you are using Internet Explorer as your Web browser, make sure it is 
configured to automatically detect LAN settings. If this default setting 
has been disabled, you will not be able to connect to the Internet.

To check Internet Explorer settings

1 Open Internet Explorer.

2 Choose Tools → Internet Options.

The Internet Options window opens.

3 Click the Connections tab.

4 Click LAN Settings.

The Local Area Network (LAN) Settings window opens.

5 Make sure the Automatically detect settings checkbox is enabled.

6 Click OK.

7 Click OK on the Internet Options window.

8 Close Internet Explorer.
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TROUBLESHOOTING
ETHERNET NETWORK SETTINGS
ARE INCORRECT

If you could not establish an Internet connection after connecting your 
computer to the SOMAport via Ethernet, but your physical connection 
seems to be intact, your computer’s Ethernet network settings may 
need to be changed.

Use the procedure in this section appropriate to your operating system 
to reconfigure Ethernet network settings. You may be prompted to 
insert the installation CD for your operating system, and you may need 
to reboot your computer after changing the settings before you can 
successfully connect to the Internet.

To change network settings in Windows 95

1 Choose Start → Settings → Control Panel.

2 Double-click the Network icon.

The Network window opens to the Configuration tab.

3 Select TCP/IP. 

If multiple TCP/IP connections are listed, select the one that contains 

"Ethernet", "NIC", or "10/100 MB" in its name, go to step 5. 

If TCP/IP is not listed, go to step 4.

4 Install TCP/IP:

i Click Add.

The Select Network Component Type window opens.

ii Select Protocol from the list.

iii Click Add.

The Select Network Protocol window opens.

iv Select Microsoft from the Manufactures list.

v Select TCP/IP from the Network Protocols list.

vi Click OK.
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vii Insert the Windows 95 CD or reboot the computer if prompted to do so.

viii If the PC reboots, repeat steps 1 to 3, then go to step 5.

5 Check the TCP/IP properties:

i Click Properties.

The TCP/IP Properties window opens to the IP Address tab.

ii Make sure the Obtain an IP address automatically radio button 
is enabled.

iii Click the DNS Configuration tab.

iv Enable the Disable DNS radio button.

v Click OK on the TCP/IP Properties window.

vi Click OK on the Network window.

vii Restart the computer if prompted to do so.

6 Check your Internet connection by launching a Web browser on the computer 
connected to the SOMAport.

If your browser automatically opens to your service provider’s Web site, 
activate full service by following the sign-up procedure that is provided on the 

Web site.

If your browser does not automatically open to your service provider’s Web 

site, go to step 7.

7 Enter a valid Internet address (such as www.google.com) in the Address field.

If the Web page opens, full service has already been activated and you can 

begin using your SOMAport for Internet service.

If your service provider’s Web page opens, activate full service by following 
the sign-up procedure that is provided on the Web site.

If your computer attempts to connect to the Internet using an old dial-up 

connection, see "The Computer Uses an Old Dial-Up Connection" on page 

59.

If you do not get an Internet connection, see "Finding Causes of Computer 

Problems" on page 48.
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To change network settings in Window 98 and ME

1 Choose Start → Settings → Control Panel.

2 Click the Network icon.

The Network window opens to the Configuration tab.

3 Select TCP/IP.

If multiple TCP/IP connections are listed, select the one that contains 
"Ethernet", "NIC", or "10/100 MB" in its name, go to step 4.

If TCP/IP is not listed, install it:

i Click Add.

The Select Network Component Type window opens.

ii Select Protocol from the list.

iii Click Add.

The Select Network Protocol window opens.

iv Select Microsoft from the Manufacturers list.

v Select TCP/IP from the Network Protocols list.

vi Click OK.

vii Insert the Windows 98 or ME CD or reboot the computer if prompted to do 
so.

viii If the PC reboots, repeat steps 1 to 3.

4 Check TCP/IP properties:

i Click Properties with the correct TCP/IP connection selected.

The TCP/IP Properties window opens to the IP Address tab.

ii Make sure the Obtain an IP address automatically radio button 
is enabled.

iii Click the DNS Configuration tab.

iv Make sure the Disable DNS radio button is enabled.

v Click OK on the TCP/IP Properties window.

vi Click OK on the Network window.

vii Restart the computer if prompted to do so.

5 Check your Internet connection by launching a Web browser on the computer 
connected to the SOMAport.
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If your browser automatically opens to your service provider’s Web site, full 

service has already been activated and you can begin using your SOMAport 
for Internet service.

If your browser does not automatically open to your service provider’s Web 

site, go to step 6.

6 Enter a valid Internet address (such as www.google.com) in the Address field 
and press Enter.

If the Web page opens, full service has already been activated and you can 

begin using your SOMAport for Internet service.

If your service provider’s Web page opens, activate full service by following 

the sign-up procedure that is provided on the Web site.

If your computer attempts an Internet connection using an old dial-up 
connection, see "The Computer Uses an Old Dial-Up Connection" on page 

59.

If you do not establish an Internet connection, see "Finding Causes of 

Computer Problems" on page 48.
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To change network settings in Windows 2000

1 Right-click the My Network Places icon and choose Properties from the pull-
down menu.

The Network and Dial-up Connections window opens.

2 Select the Local Area Connection icon.

If there are multiple local area connections, read the device name beside 

each icon and double-click the one that is associated with the Ethernet card.

If there is no icon, the Ethernet card has not been properly installed. Install 
the Ethernet card by following the manufacturer’s instructions, then return to 

this procedure.

The Local Area Connection Status window opens.

3 Click Properties.

The Local Area Connection Properties window opens.

4 Select Internet Protocol (TCP/IP).

If Internet Protocol (TCP/IP) is not listed, install it as follows:

i Click Install.

The Select Network Component Type window opens.

ii Select Protocol from the list.

iii Click Add.

The Select Network Protocol window opens.

iv Select Internet Protocol (TCP/IP).

v Click OK.

vi Insert the Windows 2000 CD or reboot the computer if prompted to do so.

vii If the PC reboots, repeat steps 1 to 4.

5 Check TCP/IP properties:

i Click Properties.

ii The Internet Protocol (TCP/IP) Properties window opens to the General tab.

iii Make sure the Obtain an IP address automatically radio button 
is enabled.

iv Make sure the Obtain DNS server address automatically radio button 
is enabled.
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v Click OK on the Internet Protocol (TCP/IP) Properties window.

vi Click OK on the Local Area Connection Properties window.

vii Click Close on the Local Area Connection Status window.

viii Restart the computer if prompted to do so.

6 Check your Internet connection by launching a Web browser on the computer 
connected to the SOMAport.

If your browser automatically opens to your service provider’s Web site, full 
service has already been activated and you can begin using your SOMAport 

for Internet service.

If your browser does not automatically open to your service provider’s Web 

site, go to step 7.

7 Enter a valid Internet address (such as www.google.com) in the Address field
and press Enter.

If the Web page opens, full service has already been activated and you can 

begin using your SOMAport for Internet service.

If your service provider’s Web page opens, activate full service by following 
the sign-up procedure that is provided on the Web site.

If your computer attempts to connect to the Internet using an old dial-up 

connection, see "The Computer Uses an Old Dial-Up Connection" on page 

59. 

If you do not get an Internet connection, see "Finding Causes of Computer 
Problems" on page 48.
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To change network settings in Windows XP

1 Choose Start → Settings → Network Connections.

The Network Connections window opens.

2 Select the Local Area Connection icon.

If there are one or more Local Area Connection icons, double-click the Local 

Area Connection icon that is associated with the Ethernet card.

If there is no icon, the Ethernet card has not been properly installed. Install 
the Ethernet card by following the manufacturer’s instructions, then return to 

this procedure.

The Local Area Connection Status window opens.

3 Click Properties.

The Local Area Connection Properties window opens.

4 Select Internet Protocol (TCP/IP).

If Internet Protocol (TCP/IP) is not listed, install it as follows:

i Click Install.

The Select Network Component Type window opens.

ii Select Protocol from the list.

iii Click Add.

The Select Network Protocol window opens.

iv Select Internet Protocol (TCP/IP).

v Click OK.

vi Insert the Windows XP CD or reboot the computer if prompted to do so.

vii Once TCP/IP has been installed, repeat steps 1 to 4.

5 Check TCP/IP properties:

i Click Properties.

The Internet Protocol (TCP/IP) Properties window opens to the General tab.

ii Make sure the Obtain an IP address automatically radio button 
is enabled.

iii Make sure the Obtain DNS server address automatically radio button 
is enabled.

iv Click OK on the Internet Protocol (TCP/IP) Properties window.
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v Click OK on the Local Area Connection Properties window.

vi Click Close on the Local Area Connection Status window.

vii Restart the computer if prompted to do so.

6 Check your Internet connection by launching a Web browser on the computer 
connected to the SOMAport.

If your browser automatically opens to your service provider’s Web site, full 

service has been activated.

If your browser does not automatically open to your service provider’s Web 
site, go to step 6.

7 Enter a valid Internet address (such as www.google.com) in the Address field 
and press Enter.

If the Web page opens, full service has already been activated and you can 
begin using your SOMAport for Internet service.

If your service provider’s Web page opens, activate full service by following 

the sign-up procedure that is provided on the Web site.

If your computer attempts an Internet connection using an old dial-up 

connection, see "The Computer Uses an Old Dial-Up Connection" on page 
59.

If you do not get an Internet connection, see "Finding Causes of Computer 

Problems" on page 48.
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To change network settings in Mac OS 8 and 9

NOTE: Your computer must have an Ethernet card and Open Transport 
networking software to connect to the Internet.

1 Click the Apple icon and choose Control Panels > TCP/IP.

The TCP/IP window opens.

2 Select Ethernet from the Connect via pop-up menu.

3 Select Using DHCP Server from the Configure pop-up menu.

4 Close the TCP/IP control panel.

If you made any changes, save them when prompted.

5 Restart your computer.

6 Check your Internet connection by launching a Web browser on the computer 
connected to the SOMAport.

If your browser automatically opens to your service provider’s Web site, full 

service has already been activated.

If your browser does not automatically open to your service provider’s Web 

site, go to step 7.

7 Enter a valid Internet address (such as www. google.com) in the Address field
and press enter.

If the Web page opens, full service has already been activated and you can 

begin using your SOMAport for Internet service.

If your service provider’s Web page opens, activate full service by following 

the sign-up procedure that is provided on the Web site.

If you do not establish an Internet connection, see "Finding Causes of 
Computer Problems" on page 48.
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To change network settings in Mac OS X

1 Click the Apple icon and choose System Preferences.

2 Choose View → Network.

3 Choose Built-in Ethernet from the Show pop-up menu.

4 Click the TCP/IP tab, if necessary.

5 Choose Using DHCP from the Configure pop-up menu.

6 Click Apply Now.

7 Restart your computer.

8 Check your Internet connection by launching a Web browser on the computer 
connected to the SOMAport.

If your browser automatically opens to your service provider’s Web site, full 

service has already been activated.

If your browser does not automatically open to your service provider’s Web 

site, go to step 6.

9 Enter a valid Internet address (such as www.google.com) in the Address field 
and press Enter.

If the Web page opens, full service has already been activated and you can 

begin using your SOMAport for Internet service.

If your service provider’s Web page opens, activate full service by following 
the sign-up procedure that is provided on the Web site.

If you do not establish an Internet connection, see "Finding Causes of 

Computer Problems" on page 48.
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IP ADDRESS NEEDS TO BE RENEWED

If you cannot connect to the Internet even after you have checked all 
cabling and network settings and have rebooted the computer, follow 
the appropriate procedure in this section to manually obtain a new IP 
address.

To obtain a new IP address (Windows 95 only)

1 Choose Start → Run.

2 Enter winipcfg in the Open field and click OK.

The IP Configuration window opens.

3 Select the network interface that has a default gateway of 192.168.1.1 from the 
pull-down list.

4 Click Release All.

5 Force your computer to obtain a new IP address by clicking Renew All.

Wait until the fields in the IP Configuration window have values in them or an error 

message appears. If you close this program before it has completed its task, you 
will have to reboot your computer before you can use your Internet service.

6 Close the IP Configuration window.
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To obtain a new IP address (all other versions of Windows)

1 Open a command window using one of the following methods:

In Windows 2000 or XP, choose

Start → Programs → Accessories → Command Prompt.

In Windows 98 or ME, choose Start → Programs → MS-DOS Prompt.

The command window opens.

2 Force your computer to obtain a new IP address by typing the appropriate 
command from the following table:

The Windows IP configuration is displayed.

3 Look for the output section related to the network interface for the SOMAport. 

Example:

Ethernet adapter:
IP address............. : 65.94.64.233
Subnet Mask............ : 255.255.255.0
Default Gateway........ : 192.168.1.1

4 Close the MS-DOS Prompt or Command Prompt window.

Operating System Command

Windows 98 or ME ipconfig /renew_all ↵

Windows 2000 or XP ipconfig /renew ↵
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SPECIFICATIONS
Release SOMAport 400

Internal antenna Type: internal passive-steered array antenna

Internal antenna gain:  3.0 dBi

Receiver noise figure:  6.0 dB

Transmitted EIRP:  30 dBm

RF output power: 27 dBm

Device ports and 
Interfaces

Ethernet: 100BASE-T (RJ-45)

USB: USB 1.1 (optional)

Telephone: Telephone terminal interface (RJ-11 jacks)    (2)

AC Adapter: Coaxial DC Power Jack, 12V/30W 

Lights Status, Network

Power 
Requirements

Power Supply: 

Type: U.S./International 100/240V AC-DC external power supply

Cable: Power cord with non-wall-mounted AC-to-DC transformer

Environmental 
Specifications 

Temperature: 
Operating: 5°C to 40°C (+46°F to +104°F)

Storage:    –20 °C to 60 °C (–4°F to 140°F)

Humidity: 
Operating: 20% to 95%, non-condensing
Storage:    5% to 95%, non-condensing

Packaging Dimensions

Height: 172 mm (6.8 inches)

Width: 150 mm (5.9 inches)

Depth: 82 mm (3.2 inches)

Weight: 1.0 kg (2.2 pounds)

Volume: 2100 cc

Regulatory 
Certifications

Radio/EMC

ETSI EN 301 753

ETSI EN 301 489-1 

ETSI EN 301 489-4

ETSI EN 300 386 

EN 55022:1998+A1:2000+A2:2003 (Class B) 

FCC Part 15B, Part 24 (PCS only), Part 27 (700MHz and WCS only)

Safety

MET (Complies with UL 60950-1, CSA C22.2 No. 60950-1)

IEC/EN60950-1
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